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How we learn and grow
आचार्यात ् पादमादत्ते पादं शिष्यः स्वमेधया ।
सब्रह्मचारिभ्यः पादं पादं कालक्रमेण च ॥

AchAryAt pAdamAdatte, pAdam shiShyaH swamedhayA |
sa-brahmachAribhyaH pAdam, pAdam kAlakrameNa cha ||
“One fourth from the teacher, one fourth from own intelligence,
One fourth from classmates, and one fourth only with time.”
Mahābhārata Udyoga Parva 44:16
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Preface
Koha, the Free library management software is a trendsetter in the library automation market since
its initial release in 2000. Koha has outwitted other proprietary automation software in popularity
and features. Many libraries with the scarcity of funds for the purchase of highly-priced proprietary
software could start the automation process with Koha. The Koha project carries the true spirit of
Free Software philosophy. A dedicated community of volunteers from different countries are
working for the development of the software. Day by day, new features, functions and
improvements are added to the software with the help of the software community. Koha offers
hope for libraries and users by providing a new generation library automation solution with the
support of cutting edge technologies.
The Koha community has developed many resources for learning, including comprehensive
documentation, and video tutorials. Learning Koha is comfortable for newbies by attending a
training programme with hands-on training. Later they can improve their expertise with the help of
community developed learning resources. This book prepared for Library Science students and
professionals who wish to learn Koha from scratch. Evolution of Koha, the popularity of Koha in
India, guidelines for the installation, usage of all modules, maintenance, and the community
resources to keep in touch with the latest developments have been discussed in the book.

10 June 2020

Authors

Contents
Introduction to Koha
Learning objectives
Introduction
Evolution of Koha
Koha in India
Koha installation and support
Conclusion
Exercise
For further reading

1
1
1
1
2
2
3
3
3

Installation of Koha
Learning objectives
Introduction
Suitable Linux distribution for Koha
Hardware selection for Koha
Installation of Koha
Koha Live DVD
Conclusion
For further reading

4
4
4
4
5
7
7
8
8

Koha administration
Learning objective
Introduction
Prepare Koha for use
Koha administration
Create a new library
Create item types
Add patron categories
Optimise Koha to send emails
Enable email messaging in Koha
Enabled Enhanced Messaging preferences
Enable overdue Notice/Status triggers
Customize email notices
Circulation and fine rules
Conclusion
Exercise
For further reading

10
10
10
10
11
12
13
14
16
16
16
16
16
16
18
18
18

Cataloguing
Learning objectives
Introduction
Creation of Biblio and Items

19
19
19
19

Add another copy of the book
Use of Authorised values with cataloguing
Enable a new field into Biblio
Edit a catalogue record
Delete catalogue record
Batch item modification
Batch item deletion
Label creation
Create a new template
Create a new layout
Create a new label batch
Inventory (Stocktaking)
Prepare text file of barcodes
Inventory process
Conclusion
Exercise
For further reading

22
24
26
27
29
29
30
31
31
32
33
36
36
36
38
38
38

Patron management
Learning objectives
Introduction
Add a patron
Import patrons bulk
Prepare the patron list
Cancel/close library membership
Add a staff patron
Conclusion
Exercise

39
39
39
39
42
42
43
45
46
46

Circulation module
Learning objectives
Introduction
Check-out (issue) of books
Check-in (return) books
Hold (Reservation) books
Conclusion
Exercises

47
47
47
47
48
48
51
51

Reports module
Learning objective
Introduction
Different ways to generate reports
Saved reports
Create a report from SQL
Conclusion

52
52
52
52
53
53
55

Exercises
For further reading

55
55

Serials management
Learning objectives
Introduction
Create a subscription
Create a Biblio
Add a vendor
Add subscription details
Receive the first issue of the journal
Manage bound volumes
Conclusion
Exercise

56
56
56
56
56
57
57
60
61
63
63

Acquisitions module
Learning objectives
Introduction
Define currency
Define budget
Create fund
Create vendor
Place orders
Order from a new (empty) record
Receiving orders
Conclusion
Exercise

64
64
64
64
65
65
67
68
69
73
76
76

Koha OPAC
Learning objectives
Introduction
Open OPAC interface
Searching
OPAC configuration
Prominent configurations
Customise OPAC regions
Quote of the day in OPAC
Create web pages in Koha
Enhanced content
Use JQuery with OPAC
Place a banner on OPAC header

77
77
77
77
77
78
78
79
80
81
81
81
82

Conclusion
Exercises

83
83

Essential Debian/Ubuntu commands
Learning objectives

84
84

Introduction
How to apply Linux commands
Some basic commands
Sudo command
APT command
Install the software from the Debian package
Open a text file using Terminal
Open a text file using Mousepad
MySQL commands
Conclusion
Exercise
For further reading
Maintenance of Koha
Learning objectives
Introduction
Update Koha
Take Koha database backup
Restore database backup to Koha
Database Restoration
Upgrade Database Schema
Rebuild the Zebra Index
Upgrade/migration from a very old version of Koha
How to seek help from the Koha community?
Conclusion
Exercise
For further reading
Get updates on Koha
Learning objectives
Introduction
Helpful resources
Koha Home page
Bugzilla
Koha Wiki
Koha DB schema
Vimeo channel
Koha newbie guide
Koha Demo
Koha mailing lists
Koha Users
Koha Library System Project
Koha Education
Blog@L2C2 Technologies
Catalyst Blog

84
84
85
86
87
88
89
90
90
91
92
92
93
93
93
93
94
94
95
95
95
95
96
96
96
97
98
98
98
98
98
98
98
99
99
99
99
99
99
99
99
100
100

Koha Geek
Librarian 2.0
An online manual of Open Source tools
Know Gate
Koha paid support
Conclusion

100
100
100
100
100
100

1

Introduction to Koha

Learning objectives
Explain the concept of Free/Open Source software.
Trace the evolution of Koha ILS.
Give an overview of Koha in India.

Introduction
Evolution of Free and Open Source software movements made history in software development
and distribution. Software developers and users could benefit from the free availability of software
and source code. Softwares for all segments of society; both personal and enterprise use, have
been developed by the Free and Open Source software community. Libraries are also beneficiaries
of Free and Open Source software. Free/Open Source Integrated Library Systems, digital libraries,
reference management tools, and content management systems are more popular among library
professionals.

Evolution of Koha
Free Software is those which are available free with source code. Free does not mean free of cost,
it denotes ‘Freedom’. According to the Free Software Foundation, "Free software" means software
that respects users' freedom and community. The users have the freedom to run, copy, distribute,
study, change, and improve the software. With these freedoms, the users (both individually and
collectively) control the program and what it does for them". The two terms, "Free" and "Open
Source" is used synonymously for the free distribution of software. Free and Open Source software
movements are two ideological groups working for freedom in software development and
distribution. In the article "Why Open Source Misses the Point of Free Software," Richard Stallman
explains: "The two terms describe almost the same category of software, but they stand for views
based on fundamentally different values. Open source is a development methodology; Free
software is a social movement". Both groups strongly believe in community participation in
software development and the Free availability of source code.
Koha Open Source library management system is a new entrant into the library automation
marketplace in India. The initial development of Koha started on September 6, 1999, by Catipo
Communications, following a request from Horowhenua Library Trust, New Zealand. Horowhenua
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Library Trust implemented Koha on January 1, 2000. The Trust released Koha under the most
popular and flexible GNU General Public License to get support from the global community and to
ensure the future development of the software. In 2000, Koha deployed in St. Joseph's College,
Devagiri, in Kerala state, India, and is considered as the first Koha installation in India.

Koha is a Māori term for a gift. Māori people, the indigenous population of New
Zealand. Many library professionals think that the term Koha is an acronym (e.g.
ASCII, NASA) and used to write KOHA. Koha is a term with meaning, not an
acronym. So don't write KOHA.

Proprietary library automation software had full dominance in the Indian market. Libraries have no
control over the proprietary library software and data. By purchasing a proprietary automation
system, libraries do not get ownership of the software. Library only gets the privilege to use the
software till the end of the service period. Often the software vendors do not give provision to
export data of books, users, and circulation. In certain instances, libraries have to make an
additional payment to terminate the existing software service and get back the data if they like to
switch over to a new one.

Koha in India
The adoption rate of Open Source library management systems in India is comparatively slow due
to a variety of reasons ranging from lack of awareness among library professionals to low
computer literacy skills. Compared to other Free/Open Source library management systems, Koha
is relatively more popular in India due to its active users' community. Many prestigious library
automation projects in India have adopted Koha due to its capability to handle Indian languages.
Delhi Public Library started using Koha in 2007. The Library has a collection of over one million
books. During the initial stages, a significant portion of the records from the CDS/ISIS database
was exported to Koha. A good number of libraries with national importance migrated to Koha and
attracted attention among other libraries. IIMs, IITs, ICAR, Central and State Universities are the
pioneers who adopted Koha in India. It leads to more Koha adoption among other libraries in India.

Koha installation and support
Koha makes use of Free/Open Source components like MySQL/MariaDB database management
system, Apache web server, Perl programming language, and Linux operating system; either
Debian/Ubuntu. There is no need to invest an additional amount for preparing a technical platform
for Koha installation. The majority of proprietary library management systems need compatible
commercial applications to run the System. In such a situation, libraries have to spend more
amount on buying database applications (e.g. MS SQL, Oracle Database), Operating Systems (e.g.
Windows), and anti-virus programs to protect the system.
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The majority of library professionals in India are not familiar with the use of Linux Operating
systems. Installation and maintenance of Koha are difficult for library professionals because of the
Linux-based installation procedures. Koha support using community resources is convenient for
libraries with IT experts. Detailed user manuals, installation procedures, data migration assistance,
active discussion forums, and blogs that are beneficial for libraries would help to maintain Koha
with in-house support. Support from commercial Koha service providers is very helpful in data
migration from legacy software, customization, development, online hosting, and maintenance.

Conclusion
Koha has now become a mature library automation software due to its strong community support.
Any type of library can adopt Koha without any hesitation. Free and Open Source software is going
through constant changes and taking new features and functions day by day. Koha releases
frequent updates with bug fixes and security enhancement. Library professionals should keep in
touch with new software developments for the efficient management of Koha for the day-to-day
activities in the library.

Exercise
1. Visit Koha's home page https://koha-community.org/, and get familiar with information
organized there.
2. Visit the online catalog of Delhi Public Library, http://delhipubliclibrary.in. Search and find
records in Indian languages.

For further reading
History of Koha
https://koha-community.org/about/history/
V, Vimal Kumar. and Jasimudeen S. “Adoption and User Perceptions of Koha Library
Management System in India“. Annals of Library and Information Studies (ALIS) 59.4
(2012): 223-30. NISCAIR.
Stallman, Richard. "Why open source" misses the point of free software." (2007)
https://www.gnu.org/philosophy/open-source-misses-the-point.html.en
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Installation of Koha

Learning objectives
How to choose the suitable Linux operating system for Koha.
Know about the selection of hardware for Koha installation.
Understand about Koha installation.

Introduction
Most of the Free/Open Source software for enterprises is developed to run on the Linux operating
systems. Koha is a Free Software and developers recommend it to install on Debian/Ubuntu Linux.
Koha has a web interface and depends on other tools like MySQL/MariaDB database server, Zebra
search engine, and Apache webserver. The server denotes a computer where the application
software is installed and running. Koha source code is written using the Perl programming
language. A server computer enables/offers software services to its users through a local
network/Internet. Users in the network can access the software services from the server computer
through client computers. If Koha is installed in a desktop/ workstation/ server computer and
made available in the campus network, we can call it a Koha server.

Suitable Linux distribution for Koha
Hundreds of Linux-based operating systems is available with a variety of features. Varieties of
Linux operating systems are known as distributions or distro (e.g. Arch Linux, Debian, Ubuntu,
Fedora, etc.). All of the Linux distributions are built on the Linux kernel. The look and feel of Linux
distributions vary depending on the desktop interfaces (e.g. GNOME, KDE, XFCE). Koha software
development is based on Debian Linux. Developers of Koha strongly recommend Debian for Koha
installation. A Linux beginner can use Debian (www.debian.org) based user-friendly Linux operating
systems like Ubuntu (https://ubuntu.com/). A stable version of Ubuntu is recommended for Koha
installation. The stable version of Ubuntu is released every two years and they offer extended
support for up to five years. You can find the "LTS" shortcode with every long-term support version
number (e.g. 18.04 LTS, 20.04 LTS). Interim releases of Ubuntu (e.g. 19.10) have only nine months
of life and are not suitable for Koha installation. Koha does not work with the RedHat family of
Linux distributions. Debian/Ubuntu and RedHat Linux distributions have lot of differences in
architecture.
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Ubuntu releases both desktop and server editions every six months. Ubuntu
desktop edition is available with a graphical interface like GNOME. The server
edition of Ubuntu is available with text mode (only commands will work). Ubuntu
LTS (Long Term Support) version is released every two years in April month.
Ubuntu LTS edition has five years of life. It means that an LTS edition will get updates for a
minimum of five years.

Hardware selection for Koha
Library professionals needs to acquire basic knowledge of hardware selection for the installation
of Koha. For hardware selection, consider budget, the number of records, the number of users, and
the transactions to be handled by Koha. Here are the suitable hardware requirements for various
library environments.
Desktop PC: The majority of libraries in India choose a desktop computer for Koha installation.
Library professionals switch off the PC before closing the library and the next day they will switch
on the PC to work with Koha. Libraries having budget constraints, lack of higher hardware
resources, and power backup would like to follow this method regardless of the number of records
and transactions with Koha. Such libraries can't offer 24x7 OPAC services with Koha on a desktop
PC.

Ubuntu Linux is available in different flavors; Xubuntu, Lubuntu, Kubuntu, etc.
Ubuntu flavors are using the same Ubuntu base and software repositories. They
keep differences in user interfaces (GUI), artwork and default programs. Ubuntu
uses a graphical interface called GNOME, Kubuntu uses KDE as GUI, Xubuntu uses
XFCE and Lubuntu uses LXQt. XFCE and LXDE desktops are known for fast performance due to
their lightweight architecture.

Libraries with a small collection (e.g. up to 25000 books) can consider a desktop with an i5
processor and a minimum of 8 GB RAM. Intel Core is a line of middle to high-end central
processing units (CPU) for computers from Intel Corporation. Core processors include the Intel
Core i3, Intel Core i5, Intel Core i7, and Intel Core i9 for desktop and laptop computers. Each
processor is available with multiple speeds. Processor speed is measured in gigahertz (GHz), the
speed at which the processor operates. For example, the Core i5 processor is available in various
speed rates, starting from 1.90 GHz to 3.80 GHz. Also available with various cache sizes, 3 MB, 4
MB, or 6 MB. Intel Core processors are also available for the server and workstation are known as
Xeon processors. The price and performance of the same core processors change based on the
number of cores, clock speed, and cache size. So specifically mention the speed and generation of
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the processor while preparing the purchase suggestion—for example, Intel Core i5 Processor 8th
generation 3.20 GHz, 6 MB cache. A processor's onboard cache is used to speed up access to data
and instructions between the CPU and RAM. Cache size is also an essential factor to determine the
performance of the computer.
Buy a desktop computer without preloaded Windows. It increases the cost of the computer. So it is
better to buy a computer without any Operating System. While placing the order, specify the
computer with the FreeDOS operating system. FreeDOS is a Free operating system. Use
Debian/Ubuntu Linux with a lightweight desktop for the optimum performance of hardware.
Ubuntu/Debian has heavyweight desktops (e.g. GNOME, KDE), and such desktops consume a
sizeable processing power of your computer. Either choose Debian Linux with XFCE desktop or
Xubuntu/Lubuntu for Koha installation. Opt SSD (Solid State Drives) over traditional HDD as
storage for fast performance. Desktop computers are not built for 24x7 service and are not
suitable to make Koha available on the Internet.
Workstation PC: A workstation computer is better than a desktop computer in terms of
performance and durability. Libraries want heavy-duty desktop machines that can opt for
workstation computers. It can handle library tasks with a large number of records, users,
transactions, and multiple library branches. Popular computer manufacturers produce a
workstation PC with different brand names. For example, Dell Precision, Lenovo Thinkstation, and
HP Z belong to the workstation category.
Server computer: Libraries with excellent IT infrastructure can choose a server-class computer for
Koha installation. Server computers built for 24x7 hours continuous working and can offer
seamless Koha service. It is observed that libraries with a small collection buy heavy-duty server
computers and switch them on and off in the evening when the library closes. This practice affects
the performance and reduces the lifespan of the server computer. Desktop/workstation computers
are enough to serve the purpose of such libraries.
Server class computers are available with various specifications. Libraries with small-size
collections can choose entry-level server computers for Koha installation. For example, HP Proliant
ML series tower server computers cost below Rs. 80000. Servers can be classified as tower, rack,
and blade based on their physical shape. Towers server built in a box chassis. Entry-level users can
choose a tower server and convenient to manage in small enterprises.
Cloud computing: Cloud computing services are becoming more convenient for all types of
libraries. Libraries can be relieved from hardware maintenance if they choose cloud hosting.
Libraries can hire cloud services from service providers like Amazon, Google, and Microsoft. It can
also choose virtual servers with Debian/Ubuntu operating systems from the cloud for Koha
installation.
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Ubuntu project maintains a list of the certified computer hardware suitable to run
Ubuntu Linux. The site retains lists of devices compatible with Ubuntu Linux. Users
can find ideal servers, workstations, and desktops to install Koha from the Ubuntu
Certified Hardware list (https://certification.ubuntu.com).

Installation of Koha
Koha Wiki (https://wiki.koha-community.org) gives detailed directions to install Koha on Debian
and Ubuntu. Check the Wiki and make sure which versions of Debian and Ubuntu are required for
the installation of current versions of Koha. Koha releases a major version every six months; in May
and November. For example, Koha version 19.05 was released in May 2019. Koha project releases
monthly updates containing security updates and bug fixes. Koha provides a Stable and Old Stable
branch for users. The latest release is called the Stable branch. Old Stable is one version behind
the current stable release. The Old Stable release is preferred for the installation because of the
more number of updates since its release. Koha version 19.05.10 means it has been updated ten
times since its release. Each monthly update of Koha contains bug fixes and security updates.
Koha Wiki updates frequently and adds timely changes to installation instructions. So one can
strictly follow Koha Wiki for the installation.

Perl is a general-purpose, high-level programming language used for a variety of
applications including web development, programming, GUI development, and
more. Larry Wall created Perl.

Koha Live DVD
The Koha Live DVD is a useful tool for learning and training purposes. Most of the Koha Live DVD is
packed with Debian/Ubuntu operating systems and a recent version of Koha. Live DVDs can be
used either in live mode or can be installed on a computer permanently. Live DVD is not advisable
to be installed for production purposes. For learning purposes, the live method is helpful. Koha Live
DVD can be booted into the computer; the user can try Linux and Koha. The live mode gives the
experience of a real-life Linux installation and Koha. It does not get installed permanently on
computer storage. Data entered by the user in live mode do not get permanently saved into the
computer storage, and it vanishes after the reboot. Koha Live DVDs are available for download.
Here is the link to a popular Koha Live DVD; https://sourceforge.net/projects/kohalivedvd/. Koha
Live DVD is easy to use and helpful for students and library professionals who would like to learn
Koha.
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Conclusion
Installation of Linux is a complicated process for library professionals. A Linux and Koha expert
can manage the installation process very well. It will be good to consult an expert or any Koha
service provider for the installation. Library professionals who are curious to learn the installation
process, are advised not to try it on the computer on which Koha is running for the library. It is
better to try the installation on another computer.
Exercise
1. Visit

Koha

Wiki

and

go

through

the

installation

steps

for

Debian,

https://wiki.koha-community.org/wiki/Debian
2. Visit https://www.debian.org/CD/ and download Debian with XFCE desktop and burn on a
CD.
3. Visit the Lubuntu website https://lubuntu.net/downloads/ and download the current LTS
version. Write on a DVD.
4. Install Debian and Lubuntu on a PC.

For further reading
Which Intel Core CPU is the best? How do I decide between a Core i3, i5, i7 or i9?
https://www.pcworld.idg.com.au/article/633263/which-intel-core-cpu-best-how-do-decide-betwee
n-core-i3-i5-i7-i9/
How to Buy the Right CPU: A Guide for 2020
https://www.tomshardware.com/reviews/cpu-buying-guide,5643.html
Ubuntu Certified hardware
https://certification.ubuntu.com
Debian Linux
https://www.debian.org/
Lubuntu Linux
https://lubuntu.net/
Xubuntu Linux
https://xubuntu.org/
Koha on Debian
https://wiki.koha-community.org/wiki/Koha_on_Debian
Koha on Ubuntu packages
https://wiki.koha-community.org/wiki/Koha_on_ubuntu_-_packages
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Koha administration
Learning objective
Learn the initial settings of Koha.

Introduction
After the installation of Koha, the user needs to configure the software to get ready for work.
Post-installation configuration loads sample data and it makes the job easy. Koha users can create
sample item types, user categories, notices, and slips, and the like. Tuning Koha software to suit
the requirements of the library is a prerequisite to start with Koha.

Prepare Koha for use
Koha has a web-based interface (it looks like a website). Users have to access Koha using a web
browser (e.g. Mozilla Firefox, Google Chrome).

Koha staff client login
Koha offers two interfaces; Staff Client and OPAC (Online Public Access Catalogue). The Librarian
has to login into the staff client to manage activities like cataloguing, circulation, reports etc. If you
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are using a computer where Koha is installed, enter the local address (http://127.0.1.1:8080 ) of the
Koha staff client in the address bar of the browser. Bookmark the Koha staff client and OPAC
addresses on the browser toolbar to avoid manually entering the URL every time. Enter the
username and password to step inside the Koha staff client. The local address of the online
catalogue (OPAC) is http://127.0.1.1.

Koha uses an Apache web server and uses two different ports for Staff Client and
OPAC. Port number 8080 is assigned to Staff Client and port number 80 for OPAC by
default. Use the port numbers with localhost, private and other addresses. For
example, http://192.168.1.2:8080 for staff clients. No need to add Apache default
port number 80 with OPAC URL, e.g. http://192.168.1.2.

Koha administration
After the installation of Koha, we need to create initial settings. Then only, Koha will be ready for
the day-to-day operations. The creation of library branches, item types, patron categories,
circulation, and fine rules are the basic parameters to work with Koha.
Visit Koha > Administration

Koha administration page
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Create a new library
Koha facilitates the management of single/multiple library branches. Multiple branches are
convenient for Universities and Colleges with more than one library branches (central and
department libraries). To create a new library, open
Koha Administration > Basic parameters > Libraries > New library

Enter the library code first. Coin a short term for your library branch code. Remember to limit the
branch code to ten characters or less. For example, MGUL for Mahatma Gandhi University Library.
Don't use special characters and put space between branch code. The software uses the branch
code as a unique identifier to recognize the particular library branch. We can't simply change the
library code, once you enter bibliographic and patron details.
Next, give the name of your library. Koha users can edit the library’s name at any time. The Library
name will appear in many places like the OPAC and also on the staff client along with bibliographic
details.
Enter the other details of the library branch. It is helpful to individualize the library branches.

Click on the submit button to save the library branch details.
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Create item types
Create item types to organize library collection based on the physical characteristics or nature of
the content (e.g., book, patent, report, thesis, reference, etc.). Koha is preloaded with some
commonly used item types. After the installation, the user can add popular item types with the
help of the web installer. Here we will learn how to add new item types;
Koha > Administration > Basic parameters > Item types

Enter a shortcode for the new item type. Coin a code that reflects the name of the item type; e.g.
REP for Reports, BBK for Book Bank. The Koha software recognizes the item type using that
shortcode.
Enter a description for the item type. Choose an ideal icon for the newly created item type from
available galleries.

Do not use item types to represent subjects. Koha offers different ways to represent
subjects or keywords for documents. Collection Code at
Koha Administration > Authorised Values useful for organising the documents
based on the collection.

Other important options:

Hide in OPAC: Hide the item types from OPAC search.
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Note for loan: Restrict item from circulation.

Add patron categories
The term 'Patron' in Koha denotes library users (e.g., Teachers, Students, Research scholars, etc.).
Visit Administration > Patron Categories to create new patron categories. Library can categorise
patrons based on the programme they joined, e.g. UG, PG, etc.

Category code: Enter a shortcode for the patron category they represent.
Description: Description of the patron category.
Enrollment period: Duration of the membership in months.

Don’t enter values in both In months and Until date fields in the ‘Enrollment period’
section.

Koha uses certain terms popular in other countries. See the terms used by Koha
and the equivalent term put in the brackets. Check Out (Issue), Check-in (Return),
Hold (Reservation), Barcode (Accession number), Label (Barcode sticker), Patron (Library user).
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Age required: Minimum age required to join the library.
Upper age limit: The maximum age for the patron category.
Enrollment fee: A membership fee is required to pay at the time of admission.
Overdue notice required: Select Yes to enable messaging facility (SMS, Email) to library users.

Lost items in staff client: Whether to display lost items in the staff client.
Hold fee: Fee for Hold (reserve) books as per library rule.
Category type: Select a suitable category (e.g. Adult for UG students).

Choose the various contexts in which notifications from Koha are sent to users. Choose to receive
their notices either as a single email or digest by checking the boxes. 'Digest only' mode delivers
the similar nature notices, generated on the same day, into one email instead of multiple emails for
each alert. For example, information on all overdue to a person on the same day in one email. This
feature helps to avoid receiving emails from libraries in the spam box.
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Koha depends on a third party MTA (Mail Transfer Agent) to send mail to users. A
lot of Free and Open Source MTA is available. e.g. Exim, Sendmail and Postfix.
Need to install any MTA and add an email account to enable the mail system.
Koha generates notices, and the MTA sends the mails to users. Libraries can use
Gmail accounts with an MTA to send email notices from Koha. Gmail allows sending a limited
number of email from a free account. Check whether the daily email quota exceeds the
permitted numbers. Hire a paidyour version of Gmail account if the number of emails from Koha
exceeds the free limit.

Optimise Koha to send emails
We need to tune Koha to send emails. Visit the following places and optimise the settings.

Enable email messaging in Koha
Apply the following command in a Terminal.
sudo koha-email-enable library

Enabled Enhanced Messaging preferences
Visit

Koha

Administration

>

Global

System

Preferences

>

Patrons

Enhancedmessagingpreferences > Allow.

Enable overdue Notice/Status triggers
Visit Tools > Overdue Notice/status triggers.

Customize email notices
Visit Tools > Notices&Slips
Koha can send notices via SMS. We need to hire an SMS service with a Perl driver.
Perl driver connects SMS service to Koha. In India, Unicel offers SMS services with
Perl driver. 'eSMS' is another SMS service suitable for Koha but limited to
government-funded libraries in Kerala state, India.

Circulation and fine rules
Rules for the circulation of library items among library users can be defined here.
Koha > Administration > Patrons and circulation > Circulation and fines rules

>
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Here we are going to create a circulation rule for Faculty members to borrow books.

See the description of each option.
1. Select a library: Create a rule either for all libraries or for individual libraries.
2. Patron category: Select the Patron category applicable.
3. Item Type: Select the Item Type to circulate.
4. Current checkout allowed: Enter the maximum number of books borrowed by users.
5. Load period: Maximum number of days the user can hold the document for reading.
6. Unit: Select the unit of time (Days/hours).

1. Fine amount: Overdue charge for items as per library rule.
2. Fine charging interval: Intervals to consider for charging and calculating the fine amount.

1. Renewals allowed (count): This shows how many times the patron can renew the item.
2. Renewal period: The number of days patrons can hold the items after the renewal.
3. Holds allowed (total): The maximum number of books a patron can reserve.
Save the circulation and fine rule after entering the values. The rule can be edited if any changes
need to be made.
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Edit mode appears on the bottom of circulation and fine rules option. Modify the rule and save.

Conclusion
Post-installation configuration of Koha is a significant process. Write down in advance the codes
used for library branches, patron categories, and item types. Keep a systematic schema and use a
specific number of alphabets (3 or 4) in codes for the Koha administration section. The user can
start the routine library works with Koha after finishing the basic parameters.

Exercise
1. Create a library branch in Koha with details.
2. Create two item types (e.g. Ph.D. Theses, Reports) for your library.
3. Create two patron categories; for UG and PG students.
4. Create circulation fine rules for UG and PG students.

For further reading
KISS your Koha patron categories
http://blog.l2c2.co.in/index.php/2020/04/02/kiss-your-koha-patron-categories/
Configure email with MTA
http://kohageek.blogspot.com/search/label/MTA
Sending email alerts via GMAIL : a marriage of convenience or is it???
http://blog.l2c2.co.in/index.php/tag/gmail/
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Cataloguing

Learning objectives
Give an introduction to the cataloging process with Koha.
Introduce how to create, edit and delete catalog records.

Introduction
The Cataloguing module of Koha helps to build a catalog of library collections: books, periodicals,
reports, theses, dissertations, etc. Koha supports both UNIMARC and MARC 21 formats for the
description of the library collection. We need to specify one format at the time of the
post-installation configuration. Libraries can enter bibliographic details in both English and other
languages. Koha supports Indian regional languages due to UNICODE support. Library
professionals can enter the bibliographic information either manually or can copy the catalogue
from other sources (e.g. Library of Congress). The cataloguing module of Koha is very
comprehensive in terms of description and display of bibliographic information.

Creation of Biblio and Items
The Koha cataloguing process includes two segments, the creation of Biblio (Bibliographic details
of records) and Item information. Bibliographic details usually include ISBN, call number, author,
title, etc. Item information contains the price, date of purchase, accession number (barcode), etc.
There are different methods to populate catalogue details into Koha. Three prominent ways to
enter the details to catalogue: add the details manually, import from MARC file, and import using
the Z39.50 protocol.

Z39.50 is an international standard, a client-server communications protocol for
searching and retrieving information from a database over a TCP/IP computer
network. Z39.50 is part of integrated library systems. Many libraries use Z39.50 to download
bibliographic details from library automation software. Koha has added a few Z39.50 servers as
default. Koha users can add more such servers to Koha. IRSpy website maintains a directory of
Z39.50 servers all over the world, http://irspy.indexdata.com.
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Here we are going to create a new catalogue record entering the details from scratch. Open the
catalogue module,
Cataloguing > New record > Books, Booklets, Workbooks
Choose a framework ideal for cataloguing the document.

Enter the bibliographic details of the book.

Make use of the Repeatable feature to generate additional fields and subfields.
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Use the 856$u field to enter the URL (Uniform Resource Locator) associated with a document. The
URL of the ebook, audiobook or supporting website can be entered here. The library users can
access the digital objects along with the book from the online catalog.

Enter the Item Type of the book.
To manage the Item Types, visit Koha > Administration > Item Types.

Save the Biblio after entering the details. It leads to the Item information page. Where we will enter
the details regarding the copy of the book.

d - Date acquired: Enter the date of purchase.
g - Cost, normal purchase price: Enter the price of the book.

21

o - Full call number: Enter the call number of the book. Add other information to book number to
make the item unique (e.g. copy number, edition).
p - Accession Number (Barcode): Enter barcode (Accession number).
y - Koha item type: Select item type for copies of the book.
Click on Add item to save the item.
Search the online catalogue and find the book and see the item information.

Koha item type option in Item information is helpful to divide multiple copies of the
book to various item types. For example, when we add five copies of a book to the
catalogue, cataloguer can assign item type Book for four copies and Reference to one copy.

Open the online catalogue in a new tab of the browser and search for the record we have saved.
See the Biblio and Item information on the online catalogue interface.

Add another copy of the book
Often libraries buy copies of the books that are already available in the library, probably due to the
demand from the user community. Sometimes we get new edition (in case of subject/textbooks)
of the existing book, then we have to create a new record. If the editions and other details are the
same, then we can add copies to the existing record. In such a context, we have to find and select
the available record with items and add additional copies to the existing Biblio.
Search for the book either using the Barcode (Accession Number) or using other details like author
and title.
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It displays the bibliographic details of the book with item information.
Click Edit > Edit items to add a new copy of the book.

Enter the item information of the second copy of the book. Remember to enter the call number
with the copy number (158.1 SHA, W;1 for the second copy of the book).
Search the online catalogue and find the book and see the item information.

23

Two copies of the same book will be visible on the OPAC.

Use of Authorised values with cataloguing
Collection management is easy and very convenient with Authorized values. Libraries need to
generate a collection wise report of records. For example, an engineering college requires a
collection wise (Mechanical, Civil, Computer, etc.) list of books. Such reports have to be submitted
to accreditation agencies (e.g. AICTE, MCI) every year. In the same way, libraries can create various
collections like biography, autobiography, and travelogue. If we add the collections to the
Authorised values in advance, the cataloguer can add each record into various collections. To
create new values to Collection Code, visit
Administration > Basic parameters > Authorized values > CCODE
Click on the Add button against the CCODE to add a new value.

1. Enter a shortcode for the new collection.
2. Enter the description for the staff client.
3. Enter the description for OPAC.
4. Select the library branch code.
5. Save the new collection.
While adding Item information, a Collection Code can be selected.
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Collection information is helpful for the library users to find the location of the book on the shelf.
See the Collection Code on the online catalogue.
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Enable a new field into Biblio
Koha users can enable or disable fields from the Biblio part. For example, 245$b for Remainder of
title/Subtitle. Imagine that 245$b hidden in Biblio. Here are the steps to follow to enable the 245$b
field and make it visible in Biblio.

Visit Koha > Administration > MARC bibliographic framework
Click on the Actions button against the desired Bibliographic framework. Select the MARC
structure.

Search for the specific MARC field.

1. Click on the Actions button.
2. Click on View subfields to enter inside the details.
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Click on the Edit button against b Remainder of title.

Whole MARC tags are organized into ten tabs (0 to 10) on the MARC Bibliographic framework in
Koha. Select the tab number from Managed in tab list to display the field on a particular tab. Select
Ignore option to hide the field.
Open the Biblio and select the specific MARC Bibliographic Framework. See the field (245$b) that
appeared on the Biblio.

Edit a catalogue record
Librarians need to edit the details of books due to various reasons; e.g. to correct the errors, to add
the missing information.
Search the document details, open the record, and edit the details.
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Use the search operator bc: to search and retrieve the correct record using the the
accession number. Example, bc:2210 will retrieve the document with 2210
accession number.

You can also search and find the record using either accession number/title/author details.

1. Select Edit > Edit record for edit the Biblio details.
2. Select Edit > Edit items to edit the Item information.
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Delete catalogue record
Search and find the record. First, delete the Items, and next delete the record.

Koha allows deleting a Biblio only after deleting all the items with the record.

Batch item modification
This feature is useful for library professionals to change a particular aspect in an Item in bulk
mode. For example, an item type of a batch of records can be changed into another one in one
stretch. This feature is available at Koha > Tools > Batch item modification.
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1. Enter the barcodes of the items, otherwise enter a text file containing barcodes.
2. Click on the Continue button.
The screen moves to the item edit page. Make changes in item information.

Save the item information. The changes take effects in all of the records in the batch. Search the
records in Staff Client or OPAC to see the changes.

Batch item deletion
This feature allows you to delete a group of items. Visit Koha > Tools > Batch item deletion.
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The next screen will list out the items to delete. Select the items fully or partially to delete.

Label creation
Label Creator assists to generate barcodes, and spine labels. Here we are going to learn to create
barcodes suitable to print on on a self-adhesive paper containing 65 labels in an A4 sheet (NovaJet
paper), which can be used for Inkjet or laser printing.
Open, Tools > Label creator. We need to create a Template and Layout to define the barcode on
paper.

Create a new template
The template defines the paper and barcode measures. Open Tools > Label creator > New > Label
Template. See the measures of 65 stickers on A4 adhesive paper.
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Create a new layout
A layout is used to define the fields (e.g. barcode, call number) that want to appear on your labels.
Use the below format to prepare a layout for a label with an accession number and call number.
Open Tools > Label creator > New > Layout.

Layout name: The name of Layout.
Choose the barcode type: Barcode encoding type.
Choose layout type: Select the combination of information to display on the label.
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Choose the bibliographic elements to be included on the label. Choose List Fields to enter the
MARC fields of the bibliographic information (e.g. 952o or Item Call Number).

Choose font type and size.

Create a new label batch
Add a few record details to generate labels. Open Tools > Label creator > New > Label batch.

Either add the barcodes of the records into the box or search and find the records by clicking on
Add item(s) button.
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Various search options are available to find and select the records to generate labels.

Select and add the records.

Biblio number of the records added to the box. Click on Add items(s) to the next step.
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Click on Export full batch to select all the records.

Choose the Template and Layout.

Download the label sheet by clicking on Download as PDF.
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Open the saved PDF file. Print the labels.

The same way, make changes in Layout and prepare spine label.
Koha users can make use of other label creators. gLabels is Free software and
distributed under the terms of the GNU General Public License (GPL). It supports
various peel-off papers. Koha users can print labels with ordinary laser/inkjet
printers. Apply the command on the terminal to install gLabels,
sudo apt install glabels

Inventory (Stocktaking)
Inventory feature assists the libraries in stock taking. After the inventory process is over, the library
gets a picture of missing books. Here are the steps to initiate stocktaking with Koha.

Prepare text file of barcodes
Prepare a text file of barcodes (accession number) either using barcode scanner visiting shelves.
Otherwise, prepare the text file with barcodes manually. If you have collected the barcodes in other
formats like a spreadsheet, copy them into the text file.

Inventory process
Visit the Tools > Inventory and upload the text file.
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Enable necessary filtering options.

Check Export to CSV file box to generate the result in a CSV file. Click on Submit button to start
the inventory process with Koha. The CSV file will be downloaded to the computer.
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Open the CSV file. Inventory report with missing documents information available in the CSV file.

Conclusion
A cataloguer can describe a document in detail with the available MARC 21/UNIMARC format.
Koha displays 999 MARC tags with the cataloguing module. Display of the whole MARC tags on
the bibliographic framework may create confusion among cataloguers. The Koha users can
customise the bibliographic framework by retaining the commonly used fields (e.g. ISBN, Author,
Title, Place, Publisher, year) for the ease of cataloguing. Keep uniformity in bibliographic details for
the generation of error-free bibliographic information and maximize the visibility of library
collection among the user community.

Exercise
1. Create catalogue records of two books (your favourite books) and create three copies of
the same.
2. Delete a catalogue record including all items and record.

For further reading
MARC standards
http://www.loc.gov/marc/
Z39.50A Primer on the Protocol: A Primer on the Protocol
https://www.niso.org/sites/default/files/2017-08/Z3950_primer.pdf
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Patron management

Learning objectives
Creation of library and staff users.
Cancel/close membership.

Introduction
The management of library users and staff is part of the Patron module with Koha. It includes the
creation, modification, suspension, and deletion of patrons. Management of overdue notifications
by email and SMS is also handled by the patron module.

Add a patron
Here the term patron denotes the library user. Following are the steps to create normal library
users like students and teachers. We are going to create a patron category for Faculty Members.
Make sure that you have created patron categories at Koha Administration > Patron categories.
To add a new patron, Koha > Patrons > New patron.

Select a patron category.
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To add more salutations like Dr., Prof, visit,
Koha Administration > Global system preferences > Patrons > BorrowersTitles

Enter the contact details of the patron to get notifications via email or SMS.
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Enter the library admission number or any other unique number in the Card number to identify the
patron.

If the OPAC is available in the campus network or on the Internet, give a username and password
for users to login.

Filed names in red-colored letters are mandatory to fill. Librarians can define the
mandatory fields. Visit Koha > Administration > Global system preferences >
Patrons > BorrowerMandatoryField

After entering the patron details, save it. An image of the library user can be uploaded to
the profile after saving the patron details.
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Import patrons bulk
Koha allows importing patron details from a CSV file. This time-saving feature is useful for schools,
colleges, and schools where a large number of patrons join every year. Here are the steps to import
patron details available in a spreadsheet file.

Prepare the patron list
Collect the details of patrons from the institution office. Often such information is maintained in a
spreadsheet file. Decide which details to import (e.g. admission number, first name, surname,
email, etc.). Copy the columns, which contains the desired patron details, into a new spreadsheet.
The header of the spreadsheet contains the field names matching with the 'borrowers' table in the
Koha database. The table borrowers store patron information. Visit Koha > Tools > Import patrons
to see all field names in the Koha database. Certain mandatory fields are also there. The
mandatory fields are 'surname', 'branchcode', and 'categorycode'. Very detailed instructions, to
prepare the spreadsheet, are available at Tools > Import patrons. Here is a sample spreadsheet
filled with patron details.

1. Field names should be the same as in the borrower’s table in the Koha database. Field
names are case sensitive. Don’t put space between words.
2. Check the Koha Administration > Libraries and confirm the branch code.
3. Check the Koha Administration > Patron categories and confirm the category code.
If anything is wrong with the field names and mandatory fields in the spreadsheet, it will end up in
the failure of patron import. Save the file into CSV format, File > Save As.
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Upload the spreadsheet in CSV format into Koha > Tools > Import patrons.

First practice with a csv file with minimum fields. Later increase the number of fields
and try to import. Field names are case sensitive. Strictly follow the field names as
such in Tools > Import patrons.

Cancel/close library membership
The Librarian has to close the patron account after the expiry of the membership period. Options
are available to add the reason to cancel membership. Librarian can enter a note about
membership cancellation.
Search and find a patron account to close. Find Patron restrictions in the bottom of the profile
page. Click on Add manual restriction.
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Library membership of a student can be closed after the programme is over.

Comment: Add a note in the comment box. Give a reason for the cancellation of membership.
Expiration: For discharge of a student no need to enter anything in the Expiration box. Date to be
filled for a short term suspension of library user (e.g. 6 months).
Add restriction: Click on the Add restriction button to save the changes.
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The patron is not allowed to check out the books after the restriction is placed. The Librarian has
the power to revoke the restriction.

Librarians can lift the restriction on users. The cancelled membership of a UG student can be
revoked when he joins the PG course in the same college in the next academic year.

Add a staff patron
Adding staff patrons in Koha will help the library staff in various sections to get individual login
power to perform routine tasks with various modules (e.g. Circulation, Acquisition, Cataloging,
etc.).
Open the patron account. Make sure that the user name and password are created for the user.
Go to More > Set permissions
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Select the modules to grant permission.

Check the desired modules. Selection of the Catalogue module is mandatory for staff login.

Conclusion
Patron module with Koha has robust features to manage user accounts. Staff patron management
is convenient for libraries with many branches and sections. Umpteen options are available with
the Patron module to manage users.

Exercise
1. Create the user account for two library users with username and passwords.
2. Create a staff patron with privileges on circulation, cataloguing, and reporting modules.
3. Close the membership of a patron.
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Circulation module

Learning objectives
Understand the processes of check-in and check-out of books.
Know the processes of reservation of books.

Introduction
The check-in (issue), check-out (return), and reservation of books form the main processes in the
circulation module. Remember to configure patron categories, patron notifications, notice
templates, calendar, circulation, and fine rules for the well functioning of the Circulation Module.

Visit Koha > Koha Administration > Global system preferences > Circulation
Go through the various preferences regarding the Circulation module and
configure it. Visit Koha > Tools and configure Notices & Slips, Overdue
notice/status triggers, and Calendar.

Check-out (issue) of books
Circulation functions with Koha can be initiated from the universal box on the staff client.
Otherwise, go to the circulation module by clicking the link from the Koha staff client home page.
Enter the patron card number/surname/first name to the Check Out option in a universal box.
Libraries can make use of input devices like barcode/QR code/RFID readers to input accession
numbers.

Next, enter the accession number of the book and press the Check Out button.
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Check-in (return) books
Enter the barcode of the book into the Check-in box.

Give other barcodes to check-in.

Hold (Reservation) books
Reservation of books offers the facility for the users to hold the book that is either on shelves or
checked out by other users. Here are the steps to reserve a book already issued to someone. First,
search and find the book from the staff client to reserve.

48

Click on the Place hold button to proceed with the reservation process.

Enter the card number/name of the library user who wishes to reserve the book.
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Click on the Place hold button to confirm the reservation.

A queue generates when more than one user places the hold. See the priority list of patrons waiting
to receive the book.
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Conclusion
Remember to edit the content in notices templates (Tools > Notices) to add library details (e.g.
contact information) and customise the message part if necessary. Run Koha on trial mode to
check the due date and calculate fine precisely.

Exercises
1. Practice Check out and Check-in for two patrons.
2. Hold (Reserve) one book for three patrons.
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Reports module

Learning objective
Give an insight into how the reports module works.
Know how to create reports.

Introduction
Report module helps the librarian to generate various types of reports regarding books, patrons,
and circulation, etc. Different types of reports are available for the convenience of the users: ready
to use reports and custom reports. Ready to use report tools can run with a graphical interface and
the librarian can generate a report without the knowledge of SQL query.

Different ways to generate reports
Koha offers various possibilities to create reports. Users can generate reports for various purposes
including data from various modules. Different tables in the Koha database store data on patrons,
documents, and circulation. The report module helps to combine information from different tables
in the Koha database and display using reports.

1. The guided report assists to generate reports through the step by step process by picking
data fields.
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2. The user can generate reports from SQL queries either by writing down the query or
borrowing from other places.
3. Saved reports are organised in Use Saved.
4. Some frequently used reports are available.

Database schema website helps to familiarize with the structure of the Koha
database. http://schema.koha-community.org. Familiarisation with the tables and
fields will help to create SQL query for report generation.

Saved reports
Saved reports are listed inside, Reports > Saved Reports section. Users can run the saved reports
at any time.

Click on the Run button to initiate a saved report.

Create a report from SQL
Libraries can create reports from scratch with the help of the SQL query. Structured Query
Language is a standard Database language that is used to create, maintain and retrieve the data
from the relational database. The SQL query is the engine that runs behind Koha reports. Reports
interact with the Koha database using the SQL query to fetch and display the report.
Koha projects maintain a library of SQL queries for reports at
https://wiki.koha-community.org/wiki/SQL_Reports_Library. The link to the Report Library can be
located on the left side of the Koha report page.
Let’s check how to create a report using SQL query borrowed from Koha SQL Report Library. Visit
the Koha SQL Report Library website and find a report. Copy the SQL query from the Koha SQL
Report library website.
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Return to Koha Staff Client. To create a new report from SQL Query, open Koha > Reports > Create
from SQL.

1. Give a name for the report.
2. Select a category for the report.
3. Paste the SQL query into the SQL box.
Run the report and see the result.
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The User can either view or download the report result. The report can be downloaded as either
CSV or ODS. CSV format is suitable to open with applications like MS Excel and LibreOffice Calc
(Open Source Spreadsheet application). ODS (Open Document Spreadsheet) files can only be
opened using LibreOffice/OpenOffice.

Conclusion
Report module offers flexible ways to generate reports for both ordinary and expert Koha users.
SQL Report Library website offers hundreds of ready to use SQL queries for report generation.

Exercises
1. Visit the Koha SQL Report Library website. Find and copy a few SQL queries of reports and
create reports.

For further reading
Koha Database schema
http://schema.koha-community.org/
SQL Report Library
https://wiki.koha-community.org/wiki/SQL_Reports_Library
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Serials management

Learning objectives
Know the process of creating a periodical subscription.
Know how to receive a periodical issue.
Describe the procedure to manage bound volumes.

Introduction
The Serials module assists in managing the subscription of journals, magazines, newspapers etc.
This module is helpful to record and track periodicals. Library users can quickly know the
availability of periodicals through an online catalogue.

Create a subscription
The library can start to create a subscription of periodicals with Koha when the first issue arrives.

Create a Biblio
First, we need to create a catalogue record of the periodical. Only need to create a Biblio of the
record. Open cataloguing module and create a Biblio, Koha > Cataloguing.

Enter the details of the journal including ISSN, title, publisher etc. Save the Biblio. No need to save
the Item information.

Adding a journal jacket to catalogue records will be more attractive and users can
easily recognise each journal while searching OPAC. Journal cover pictures can be
collected from the publisher website. Upload the journal cover to the Biblio.
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Click on the Images tab. Upload the journal cover.

Add a vendor
If the library is subscribing to the periodicals through a vendor, create a vendor/supplier.
Koha > Acquisitions > New vendor.

Add subscription details
Start the subscription in Koha when the first issue of the journal arrives.
Enter into Koha > Serials > New subscription.

1. Search and find the vendor.
2. Search and find the Biblio of the journal.
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Decide whether we need to issue a barcode to each issue of the journal we received. Libraries that
allow to check out old issues of periodicals for reading, can follow this practice.

Call number: Item’s call number of the journal.
Library: The name of the branch that subscribed to the journal.
Public note: Information on the OPAC for the patrons (e.g. Discontinuation of a particular volume)
Nonpublic note: Notes that are only visible to the librarians via the staff client (e.g. Payment details
of subscription).
Patron notification: Notice sent to patrons on the arrival of new issues (Routing list).
Location: Shelving location of the journal.
Grace period: The number of days before an issue automatically moves from ‘Expected’ status to
‘Late’.
The Staff and OPAC display options allow you to control how many issues appear by default on
bibliographic records in the Staff Client and the OPAC.
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First issue publication date: First issue of the journal after the subscription starts.
Frequency: Various frequencies of the journal (e.g. Weekly, monthly, quarterly etc.)
Subscription length: The number of issues or months in the subscription.
Subscription start date: The date on which the subscription begins.
Subscription end date: End date of the current subscription.
Numbering pattern: The numbering pattern is followed by the journal (e.g. Volume, Issue).
Locale: To display days, months, the season in regional language (e.g. Persian).
Click on the Test prediction pattern to get an idea of the issue numbering of the journal.
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Click on the Save subscription button.

Receive the first issue of the journal
The subscription process in Koha starts after receiving the first issue of the journal.

Change the status from Expected to Arrived. You can enter the speciality of the issue on the Notes
section (e.g. Branding special issue).
The current issue of the journal is received and waiting for the next issue.

Search and find the journal at OPAC. See the bibliographic and holding details of the journal.
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Manage bound volumes
Koha can handle bound volumes of periodicals. Users can understand the availability of bound
volumes of periodicals along with the latest and previous issues.
First, create an item type for bound volume.
Administration > Item types > New item type.

Next, find the Biblio of the journal to attach bound volume details.

Create an item for the journal bound volume, Edit > Edit items.
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Enter the details regarding the bound volume.

1. Enter the volume and issues contained in the bound volume.
2. The accession number of the bound volume.
3. Add the item.
See the bound volume details of the periodical at online catalogue.
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Information of the bound volume appears at the Holdings tab.

Conclusion
Management of periodicals is considered as one of the responsible tasks in libraries and Koha can
handle it very well. Periodicals module can manage the subscription through both vendors and
publishers. The libraries can manage the bound volumes of periodicals with the help of the serials
module.

Exercise
1. Create a subscription of two journals with two different frequencies (Monthly, Weekly).
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Acquisitions module

Learning objectives
To get familiar with the acquisition process in Koha.

Introduction
Procurement of books goes through various stages. It requires systematic monitoring to avoid
unnecessary delay. Acquisition module mechanises the procedures from receiving purchase
suggestions to fast delivery of documents to the library users. Acquisition module can handle
budget, vendors, ordering, and receiving of documents.

Define currency
Define an active/default currency for transactions to start the Acquisition module with Koha. Indian
libraries follow transactions in Indian Rupees (INR). To define active currency go to Administration
> Acquisition parameters > Currencies and exchange rates > New currency.

Enter the standard currency code, base rate, symbol, and ISO code. Don’t forget to check on the
Active box. Put the currency symbol by using the keyboard or copy from any website.
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Define budget
Often libraries receive an allocation of money to meet the expenses from the parent institution.
Libraries meet the expenses including salary, purchases, etc. from the budget allocation.
To create a new budget, go to Administration > Acquisition parameters > Currencies and
exchange rates > Budgets administration > New budget.

Start date & End date: Define the period of the budget based on the nature of financial allocation
(e.g. financial year, academic year).
Description: Give a meaningful description for the budget which should reflect nature and period of
time.
Total amount: Total amount should not contain special characters like a comma.
Not allowed to create Funds after locking the budget.

Create fund
Libraries need to create funds in the budget for the purchase of library resources (books,
e-resources). Libraries can create various funds based on the nature of the items and their
purchase. Let’s create a fund for book purchase.
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Open the Actions button and click on Add fund.

Fund code: Give a Fund code.
Fund name: Description of the fund and it should reflects the nature of the fund.
Amount: Allott an amount to the fund.
Warning at (%): Alert to inform fund scarcity.
Owner: Select an Owner for the fund.
Library: Select the library.
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Restrict access to: Restrict who can order from this fund by choosing either the ‘owner’, ‘owner and
users’ or ‘owner, users, and library’.

Create vendor
Libraries assign vendors (booksellers) to procure books and other resources. Order for books is
placed through vendors.
To create a vendor, Acquisitions > New vendor

Enter details of the bookseller with contact information.
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Make the vendor Active.
Enter other details like discount rate and delivery time.

Place orders
Academic community places suggestions to purchase books. Library sorts out the titles and
places the order to booksellers. Enter into the Acquisitions module, search and find out a vendor.

Placing an order for books is the same as picking items to basket in a shop. First, we have to
create a basket to enter the details of books to place an order. Click on the New basket button
against the vendor name.

Enter details of the basket.
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Give a meaningful name to the basket.
Select, when we want to create an item and assign an accession number. The default option is that
item creation at the time of cataloguing the record.

Order from a new (empty) record
Library staff has to add the details of the book into the basket.
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It is possible to add details of books you wish to purchase from various ways. Here we are going to
enter the details of a book from scratch.

Start going to enter the details of the book from scratch.

Enter the bibliographical details of the book.
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Enter quantity, price, and discount of the book. Save the book details.

Click on the Add to basket button on the basket summary screen to enter other books details to
purchase.
See the summary of items in the basket after saving the book details.
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Close the basket after entering all the details of books to purchase.

When closing the basket, add the basket to a group for easy printing and retrieval.
Check the box to Attach this basket to a new basket group added to the group list.
It is possible to export a statement of the order in PDF format.

We can get the order statement either in PDF or CSV format.

The library can send the order statement to the vendor.
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Receiving orders
The books receiving process can be started when they arrive from vendors. First, identify the
vendor who has sent the books. Then go to the Acquisitions module and search the vendor.

Click on the Receive shipment button and start the receiving process of books.
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Enter the Vendor invoice number and date.

Receive the books by clicking on the Receive button on the right side.
The next page displays the quantity ordered and received. The librarian can make any changes in
price.
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After receiving the books, the library can start the cataloguing process.

The title of the book with a link leads to the cataloguing module. Enter the complete bibliographic
details, item information and finish the process.

Here is the status of the fund after receiving the orders. The fund status indicates the total amount
spent and the remaining fund.
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Conclusion
Acquisition module of Koha offers both traditional and latest ways to manage the procurement of
books. Libraries can receive purchase suggestions from various sources and place orders. Budget
and fund management are very flexible and give a precise picture of the fund.

Exercise
1. Create a budget and fund for book purchasing.
2. Create a vendor and place an order for two books.
3. Receive the orders and catalogue the books.
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Koha OPAC
Learning objectives
Introduce the features of OPAC.
Give an overview of OPAC settings.
Guide to do OPAC minimal customisations.

Introduction
Koha OPAC (Online Public Access Catalogue) is the interface for library users and the public. Users
primarily make use of OPAC search to know the availability of documents in the library. Besides,
Koha OPAC can be converted as a library portal and publish information for user’s attention. Koha
OPAC provides enough room for customisation of the user interface.

Open OPAC interface
Koha OPAC interface is available in another port. The default port number is 80. If Koha is installed
on the computer you are working on, then open the localhost, http://127.0.1.1 using a browser. If
Koha is installed on a computer in the network or cloud, enter the IP address (e.g. 192.168.1.1) or
URL of the OPAC (e.g. mgucat.mgu.ac.in).

Searching
A box for a simple search on the OPAC home page.

Koha OPAC also provides an advanced search. Users can open the advanced search page from the
link below the simple search box.
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The advanced search offers more options for a comprehensive result. Search filters are also
available for a precise result. Users can filter the result based on library branches, items types,
collection, authors, etc.

OPAC configuration
Configurations related to the OPAC can be found at Koha Administration > Global System
Preferences > OPAC.

Prominent configurations
Here a few prominent configurations are introduced. Use the search and find feature in the browser
to locate the configuration. Press Ctrl + F buttons to open the search box in the browser. Copy and
paste the name of the configuration in the search box. Action buttons or text boxes can be found
against each OPAC preference. Users can enable or disable each preference by clicking on the
button. Save the preference after making the changes.

Name of the preference

Description

GoogleIndicTransliteration

GoogleIndicTransliteration on the OPAC. Helpful to
search using regional languages.

LibraryName

Enter the library name in the box. Which displays the
library name on the browser tab.

OpacFavicon

Make use of this preference to display the institution logo
on the browser tab.

OpacMaintenance

Provision to disable OPAC at the time of maintenance.
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OpacMaintenanceNotice

To give a maintenance notice to display.

OPACUserCSS

CSS (Cascading Style Sheets) is a style sheet language
useful to beautify the OPAC interface. Koha users can
apply CSS here to make the OPAC beautiful.

OPACUserJS

JavaScript can apply for OPAC modification. Koha project
maintains a website to store readymade JQuery
statements. Users can copy the queries from the JQuery
library website to enable new features. JQuery Library
URL,
https://wiki.koha-community.org/wiki/JQuery_Library

opacuserlogin

Enable or Disable user login from OPAC from here.

suggestion

Enable to receive purchase suggestions from library
users through OPAC.

OpacRenewalAllowed

Enable or disable the facility to renew books on the
OPAC.

OpacPasswordChange

This option allows changing user passwords on the
OPAC.

OpacAllowPublicListCreation

Permit users to create public lists on OPAC.

AnonSuggestions

Whether allow making purchase suggestions by users
without logging in.

Customise OPAC regions
Koha OPAC can be customised in two ways; either by using the options in system preferences or
using scripts like CSS. Users without knowledge on scripting, can manage the customisation using
system preferences. Let's check the options for OPAC customisation at system preferences.
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OPAC home editable blocks.
System preferences related to content in OPAC editable blocks.
Name of the preference

Description

opacheader

Display library name either as text or image on OPAC
heading space.

OpacNav

The left-hand column of the main page. This space is
suitable to add links to other websites using HTML.

OpacNavBottom

Another space below the OpacNAV.

OpacMainUserBlock

OpacMainUserBlock is the largest block on OPAC. It’s
customisable space. Library staff can add text and
images using HTML.

opaccredits

Space at the footer.

OpacNavRight

Enter HTML that will appear below the login box on the
right.

QuoteOfTheDay

Display random quotes on the OPAC home page.

Quote of the day in OPAC
Quote of the day feature in OPAC helps to display random quotes on the OPAC home page.
Enable the QuoteOfTheDay feature from System Preferences.
Add some quotes, Tools > Edit quotes for QOTD feature
Open OPAC interface and refresh the page to make visible the quotes on OPAC page.
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Create web pages in Koha
Users can publish pages on Koha OPAC. Then OPAC can act as a library portal.
Very detailed documentation is available at Koha Wiki:
https://wiki.koha-community.org/wiki/Koha_as_a_CMS

Enhanced content
Enhanced content is useful to connect with other sources. Users can find prominent service
providers like Amazon, Google, LibraryThing, etc. in the list at system preferences. Such services
are primarily used to display book jackets along with record details.
Visit the option at Koha Administration > Global system preferences > Enhanced content.
Enable one service at a time. Otherwise, multiple book jackets will be displayed on OPAC.

Display of book jacket using Google Books

Use JQuery with OPAC
JQuery is an easy method to use JavaScript on websites. Koha makes use of JQuery to customize
the look and feel of staff client and OPAC interfaces. Koha users can borrow readymade JQuery
snippets from the Koha JQuery Library website. Here is an example of the application of JQuery on
OPAC.
Application: Remove the "No cover image" message on the OPAC.
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“No cover image” along with Google book cover.
Solution:

Visit

the

Koha

JQuery

Library

https://wiki.koha-community.org/wiki/JQuery_Library and find the script.

Copy the highlighted JQuery and paste it into,
Koha Administration › System preferences > OPAC > OPACUserJS
Save the preference. Check the change in OPAC.

Place a banner on OPAC header
A beautiful banner on the header of Koha OPAC can beautify the home page.

Create a banner for Koha OPAC.

website:
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To put the image in /usr/share/koha/opac/htdocs folder, apply the following command in a
terminal.

sudo mv header.jpg /usr/share/koha/opac/htdocs

Open Koha and go to System Preferences > OPAC > opacheader
Apply the HTML code to display header image,

<img src="header.jpg" style="width:100%;height:100%;">

Save the changes. Open OPAC page and refresh the page to see the header.

Conclusion
Koha offers comprehensive features with OPAC. It can act as an interface for searching and can be
converted as a library portal. Libraries can connect with third-party services like Amazon and
Google to display book jackets and reviews, along with records. Koha users need to be familiar
with HTML tags, CSS, and related tools to manage the OPAC customisation well.

Exercises
1. Visit the Koha JQuery Library website and find and apply useful queries to your Koha
installation.
1.
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Essential Debian/Ubuntu commands

Learning objectives
Get an understanding of the basic Debian/Ubuntu commands.
Build the capacity to install/remove a new package using APT commands.
Describe how to maintain the Debian/Ubuntu update.

Introduction
The knowledge of basic Linux commands will be an added advantage for library professionals
working with Open Source software on Debian/Ubuntu. APT is a package management system
used by Debian and Ubuntu. APT commands are helpful to maintain the Debian/Ubuntu operating
system for the update, upgrade, install and uninstall software packages. An understanding of
Debian/Ubuntu Linux operations is essential for the effective management of Koha.

How to apply Linux commands
The tool used to apply commands on a Linux operating system is called Terminal. Whatever may
be the Linux, you can open Terminal in application launcher,
Applications > System Tools. The Terminal can also be opened using the short key, by pressing
Ctrl + Alt + T buttons together.

Linux command Terminal
There are specific rules to be followed when using Linux commands. Otherwise, the Linux
operating system will refuse to execute the commands. Beginners may find it a bit difficult when
dealing with Linux commands in the initial stages. The lines of instructions for Linux must be
case-sensitive. Whether the commands are in lower or upper case, they must be entered as such.
Otherwise, the command will be misinterpreted and exit without implementation. Linux commands
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can have multiple parts. Space should be placed between each part. The Linux operating system
refuses to apply commands without proper syntax. Beginners of Linux should be careful to follow
syntax while applying commands. Type the command on the terminal and press the Enter button
to apply the command. If the command is applied correctly, the result will be displayed on the
Terminal screen or jump to the next prompt. If the command is not valid, either error message or
message suggestions will be displayed.

Some basic commands
Here are some basic commands to manage Debian/Ubuntu Linux. The below mentioned
commands will help the library professionals to familiarise the application of Linux commands.
The user has to apply the commands from the Terminal tool.
Know the Debian/Ubuntu version
It is important to know the version of Debian/Ubuntu Linux installed on your computer. Apply the
following command,
lsb_release -a
Know the system information
This command displays details of the computer specifications.
lscpu
Know the current user
The following command will display the name of the current user who logged in.
whoami
To know the current working directory
The command will display the current location of the working directory.
pwd

To check the current system date and time correct
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The user can validate the date and time by using the command.
date
Clear the screen
Working with commands makes the terminal screen shabby. It clears the screen filled with
commands.
clear
To know the IP address of your computer
An Internet Protocol address (IP address) is a numerical name system assigned to each computer
connected to a network that uses the Internet Protocol for communication. This system facilitates
the easy identification of a computer in a network. The IP address is the same as a unique
identification number (e.g. admission number) followed by a College to identify each student.
ip a
Identifying the IP address of the computer is helpful for libraries to make available Koha staff client
and Online catalogue in campus network/Internet.

Sudo command
The administrator account in Linux is called Root User. The Root User has the ultimate power to do
important tasks on Linux. By default, the root account password is locked in Ubuntu. This means
that you cannot log in as root directly. Users are allowed to use the sudo command to become the
root user. The sudo command stands for "Super User DO". The Debian/Ubuntu users have to apply
commands with the sudo as a prefix. For example,
sudo apt update
Password will be asked whenever you apply the command with sudo. Type the password of the
account created at the time of Ubuntu installation. The * symbol is symbolically displayed when a
password enters on the Windows operating system. While typing a password in a Linux terminal,
nothing will be seen on the screen. Type the password in the blank space and press the Enter
button. The command will start running and display the result.
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Once a command with sudo applies, it won't ask for the password for 15 minutes.
After 15 minutes; the system will ask for the password again.

APT command
APT is a command-line tool for software package management with Debian and Ubuntu. APT
stands for Advanced Packaging Tool (APT). It handles updating, installation, and upgrading of
software packages.
Update the Package Index
Ubuntu software repositories are available all over the world where a collection of software
packages are stored. Ubuntu software repositories are available in India too. Ubuntu users in India
receive updates from the repositories for Indian users. The software repositories in the nearby
places help the users to download the updates faster. Addresses of the software repositories are
stored on the computer where Ubuntu is installed. For example, the new version/update of
LibreOffice Software first appears in the software repository. The Ubuntu user needs to fetch the
latest version packages from the software repository.
Type the following command to update the package index on your computer with the latest
package information available in the repository. While using update commands, the user should
make it sure that the computer has Internet access.
sudo apt update
Upgrade packages
Use the following command to download and install the latest version of the software and
associated packages that are currently installed.
sudo apt upgrade
Install a specific package
The installation of packages using the apt tool is quite simple. For example, to install the Bluefish
Editor, type the following,
sudo apt install bluefish
Install multiple packages
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The user can install more than one package from the same command. For example, the following
command will install packages ‘bluefish‘ and ‘mousepad‘.
sudo apt install bluefish mousepad
Uninstall a package
Type the following command to remove the package installed in the computer,
sudo apt remove bluefish
Completely remove packages
To remove software packages including their configuration files, use the purge command as
shown below.
sudo apt purge filezilla
Clean up disk space
The clean command is helpful to free up the disk space by cleaning downloaded .deb files from the
local repository (/var/cache/apt/archives).
sudo apt clean
Apply autoremove command to clean up unwanted packages from the system.
sudo apt autoremove
The autoremove command will remove the unnecessary dependency packages to remain in the
computer after the uninstallation of application software.

Install the software from the Debian package
There is also a way to install software that is not in the Ubuntu software repository. Software such
as Google Chrome and Anydesk is not available in the Ubuntu software repository. The package
file should be downloaded from the website. Select the package suitable for the architecture of the
computer; 64-bit/32bit. Latest computers support 64-bit. Architecture type is always mentioned on
the package file. Download the package file suitable for 64-bit architecture. Open the File Manager
and move the package file from the Download folder to the Home folder. The extension of the
Debian package is .deb and is similar to the .exe extension with the Windows application installer.
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Apply the following command to install the Debian package of Google Chrome browser.
sudo dpkg -i google-chrome-stable_current_amd64.deb
The package google-chrome-stable_current_amd64.deb is lengthy and has a chance to get an
error while typing. If the package name given is not correct, the installation attempt will fail. There
is an easy way to enter the package name correctly. Press the Tab button after typing the first few
lines of the package name (e.g. sudo dpkg -i goo), it will autofill the rest of the name. Another
method to get the full file name is to put the * symbol after the few letters.
sudo dpkg -i google*
In some cases, the installation of a Debian package may fail due to the lack of additional software
packages. In such a situation, apply the following command to download the missing packages to
finish the installation.
sudo apt install -f
The software icon will appear along with the other applications after the installation. Open the
application software by pressing the mouse on the icon.

Open a text file using Terminal
On many occasions, Linux users need to open files and make changes to it. First, make sure which
text editor application is available on your computer. Text editor applications can be found at
Applications > Accessories. Linux-based operating systems are using different applications for the
default text editor. For example, GNOME uses Gedit. Install a new text editor, if you are not sure
about the name of the default text editor. The mousepad is a lightweight text editor. To install
Mousepad, apply the following command:
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sudo apt install mousepad

Open a text file using Mousepad
First, find the location of the file to open. For example, apply the following command to open the
syslog file located at /var/log. We use the Mousepad text editor to open the file.
sudo mousepad /var/log/syslog
Syslog file contains the running history of each movement in Linux.

MySQL commands
Koha makes use of MySQL/MariaDB as the database. MariaDB is a community-developed project
derived from the MySQL database management system. MariaDB is a Free database management
system licensed under the GNU General Public License.
Here are the few basic commands to be familiar with MySQL/MariaDB operations. Apply the
following commands in a terminal.
Enter into MySQL
sudo mysql -u root -p
First, it will ask for the Debian/Ubuntu password, and after that, it will ask for MySQL/MariaDB Root
user command.
Create a database
create database micky;
Show databases
show databases;
These commands will list out all databases.
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Delete database
drop database micky;
Enter into a database
If you are working on a Koha Live DVD, try the following commands. The default name of the Koha
database is koha_library. Try the commands in a test machine using Koha Live DVD. Don’t try these
commands on a Koha production system. It will badly affect the running instance of Koha.
use koha_library;
Display tables
show tables;

Show table structure
describe biblio;
This command will display the structure of the table called Biblio.
Show the content inside the table
SELECT * FROM biblio;
Exit from the MySQL/MariaDB console
exit

Conclusion
The apt commands are beneficial for the library professionals and system administrators to
maintain Koha on Debian/Ubuntu. No need to learn by heart all the Linux commands. Search and
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find commands with the help of Google when it is required. The more you use commands, the
more familiar they become.

Exercise
1. Install Filezilla application using the apt command.
2. Visit anydesk.com website and download the .deb file. Install the package using dpkg
command.

For further reading
About MariaDB server
https://mariadb.org/about
The Debian GNU/Linux FAQ
https://www.debian.org/doc/manuals/debian-faq/index.en.html
25 Useful Basic Commands of APT-GET and APT-CACHE for Package Management
https://www.tecmint.com/useful-basic-commands-of-apt-get-and-apt-cache-for-package-manage
ment/
How To Check Your IP Address in Ubuntu
https://itsfoss.com/check-ip-address-ubuntu/
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Maintenance of Koha
Learning objectives
Get an understanding of updating to the latest version of Koha.
Learn how to manage database backup securely.
Learn to restore a database backup to a new Koha installation.

Introduction
Timely maintenance of Debian/Ubuntu and Koha is essential for the good health of Debian/Ubuntu
and Koha. Regular updating of Linux and Koha are required to keep the system up to date. Backing
up the Koha database is part of data security. If a crisis occurs, the process of restoring database
backup to a new Koha installation is a life saving task.

Update Koha
Koha releases a new version every six months (May and November) with a bundle of new features.
The current version is called Stable and the previous version is called Old Stable. Major releases of
Koha receive monthly updates. Debian and Ubuntu also release updates frequently. Debian/Ubuntu
update and upgrade commands are enough to upgrade Koha to the latest releases. Apply the
following command in a terminal,
sudo apt update
sudo apt upgrade
Clean the packages after the upgrade process over.,
sudo apt-get clean

Information regarding the installation and other technical details available at
Koha > About page. We can find many tabs in this page. Server information tab gives
information about the Koha version and the Linux platform Koha running. Warnings
about Koha display at System Information tab.
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Take Koha database backup
Koha stores all information regarding documents, patrons, circulation, and other things stored in
the database. To a certain extent, taking the backup of the database and keeping it in another
storage place is enough to secure the data. Here are the steps to grab the database backup of
Koha. Apply the following command in a terminal,

sudo

mysqldump

-ukoha_library

-p

koha_library

|

xz

>

koha_library.sql.xz
Above mentioned is a single line command. Enter the Linux password first, then enter the
password of the Koha database. The database backup will be generated and compressed into XZ
format. Keep the database backup in other storage devices like flash (e.g. pen drive) or cloud
storage.
Koha users can schedule the process for regular backup. Scheduling of backup is possible with a
tool called Cron with Linux based operating systems. Cron helps to plan and schedule the tasks on
a specific time as a one time task/repetitive basis. For example, the backup can be scheduled at 8
pm every day. Do a search in the web for cron in Linux and get familiar on how to apply.

Restore database backup to Koha
Assume that the existing Koha installation is collapsed (Don’t let that happen) and the database
backup is safe with you. Install Koha again. Follow the steps to restore the database backup to a
new installation.
Remove the existing database in the new Koha installation.
sudo mysql -uroot -p
[Enter the Linux password and enter MySQL Root password]
Delete the existing database and create a blank one.
drop database koha_library;
create database koha_library;
quit;
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Copy your database backup from your pen drive to the home folder. If the file is in compressed
format, extract the backup file. The extension of the MySQL backup file will be .sql. Then restore
the old backup to the new Koha installation.

Database Restoration
Apply the following commands in a Terminal one by one.
sudo mysql -uroot -p koha_library < koha_library.sql
exit

Upgrade Database Schema
The database schema of old Koha should be upgraded to match with the new version. Apply
following commands in a terminal one by one.
sudo service memcached restart
sudo koha-upgrade-schema library

Rebuild the Zebra Index
Koha uses a third party search engine called Zebra for search and retrieval of records. Apply the
following command in a terminal to refresh the search index.
sudo koha-rebuild-zebra -v -f library
After rebuilding the Zebra Index, Koha becomes ready to use.

Upgrade/migration from a very old version of Koha
Libraries stick on with old versions of Koha facing difficulties while trying to upgrade to the new
version. Upgrading from very old versions to the latest version may result in data loss. Koha stops
the official support for older versions after a specific period. New versions of Koha introduce a lot
of improvements and new features. Changes in database structure are required to accommodate
new features. For example, Koha version 3.18 was released in 2014, and it has 168 tables. Version
19.05, released in 2019, has 204 tables. Koha developers strongly recommend for the regular
upgradation to recent versions. The database structure is also subject to changes during the
upgrade process.
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Direct upgradation from old versions (e.g. versions before version 3.18) to the latest version
probably ends in data loss. Restoration of an old version of Koha is a challenging task. Data
migration from a running instance of an old version of Koha is comparatively easy. Porting of
bibliographic records to MARC format, patron details, and circulation details to CSV is possible.
Then it can be imported into a new version of Koha. Following steps can follow to export essential
data:
❖ Note down all configurations with Koha including branch code, item types codes,
authorized values, circulation, and rules. Take screenshots of all configurations.
❖ Export bibliographic details (MARC format) into MARC. Export patron and circulation
details into CSV format using reports.
❖ Install a new version of Koha. Create branch code, Patron categories, Authorised values,
circulation match with the old version of Koha.
❖ Import MARC file, patron, and circulation details.

How to seek help from the Koha community?
Koha users rely on community members to clear doubts, errors, and problem-solving. Email
discussion forums and social media groups are available for users to interact with Koha experts.
Include a detailed description of the error/problem in the message in simple words. If possible, add
a screenshot that describes the error with the message. Mention the database server details,
version of Koha, and Linux-based operating system. Visit the About Koha > Server information tab
to get the version details of Koha, database server, and Linux. A detailed message helps the Koha
community members to get the exact picture of the problem, and the high chance of getting a reply
with a solution.

Conclusion
Library professionals should be familiar with the maintenance activities of Koha like upgrading
when a new release arrives, regular backup of the database, and restore the database when a crisis
happens. Upgrading from a very old version to a new one is a challenging task. Seek the assistance
of an expert to recover the data from the old database and migrate to the latest version.

Exercise
1. Visit the koha-community.org website and find the latest and previous Koha version release
announcement. Go through release notes.
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For further reading
Koha backup
http://kohageek.blogspot.com/search/label/backup
CronHowto
https://help.ubuntu.com/community/CronHowto
Move old Koha database to new installation
http://kohageek.blogspot.com/search/label/Restore
Understanding Zebra indexing
https://wiki.koha-community.org/wiki/Understanding_Zebra_indexing
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Get updates on Koha

Learning objectives
Introduce various resources to keep in touch with Koha developments.

Introduction
Koha is a community-owned project, and the development is fast. Always expect new changes in
technical matters, features, and functions. Koha users need to keep in touch with the
developments. Then only successful Koha management is possible.

Helpful resources
Following resources are helpful to learn new things and get updates on Koha:

Koha Home page
The home page of the Koha ILS project is http://koha-community.org. Koha home page is a
comprehensive information portal. User can find the following resources at the Koha home page:
Koha documentation: It contains complete Koha user manuals in various languages. User manual
covers all Koha modules with screenshots. Previous FAQs merged with the user manual. URL:
https://koha-community.org/documentation.
Koha Community Newsletter: The monthly newsletter discusses the latest developments, news,
tips, coming, and past events.
Release notes: It lists out all features and changes available with the latest versions of Koha.
Following are the other places where Koha users get valuable information.

Bugzilla
Koha users can report bugs (software errors) and suggest new features.
URL: https://bugs.koha-community.org

Koha Wiki
Installation manuals and other tutorials available with Koha Wiki.
URL: https://wiki.koha-community.org
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Koha DB schema
Koha database schema is made available to the public and is helpful to know the database
structure, table, and field names. The information on database structure is useful at the time of
report making.
URL: http://schema.koha-community.org.

Vimeo channel
Videos, tutorials, and other information from Koha users.
URL: https://vimeo.com/channels/kohails

Koha newbie guide
This newbie guide was created by B.W. Johnson. Little bit old one, but useful to get an overview of
the Koha workflow for beginners.
URL: http://staff.washington.edu/rmjost/Kohanewbieguide.pdf

Koha Demo
Koha home page listed out demo instances for learners.
URL: https://koha-community.org/demo/

Koha mailing lists
Koha projects maintain different email lists for various purposes. The general mailing list is an
excellent platform to interact with developers and users together. Users can put queries and
receive answers from users and experts. Archives of the email discussion forums act as a useful
reference source.
URL: https://koha-community.org/support/koha-mailing-lists/

Koha Users
There is an active Facebook group for Koha available. Answer the questions regarding Koha, to join
the group.
URL: https://www.facebook.com/groups/475420505905835/

Koha Library System Project
The official Facebook group of Koha users.
URL: https://www.facebook.com/groups/475420505905835/

Koha Education
ByWater Solutions, a Koha service provider, offers Koha learning materials.
URL: https://bywatersolutions.com/education
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Blog@L2C2 Technologies
A blog started by L2C2 Technologies and Indranil Das Gupta. Indranil Das Gupta is a pioneer of
Koha from India.
URL: http://blog.l2c2.co.in

Catalyst Blog
A blog discusses both Open Source and Koha things. Catalyst is an Open Source software service
provider from New Zealand.
URL: https://www.catalyst.net.nz/about-us/blog

Koha Geek
Koha tutorials, tips and tricks discussed in this blog.
URL: http://kohageek.blogspot.in

Librarian 2.0
A blog maintained by Mahesh P Pandallur, a young library professional from Kerala, India. His blog
is useful for Koha users to learn and try new things.
URL: http://libtechnophile.blogspot.com

An online manual of Open Source tools
A website that contains Koha learning materials. The website is maintained by D.P. Tripathi,
Assistant Librarian, Biju Patnaik Central Library, National Institute of Technology Rourkela, Odisha.
URL: http://www.dptripathi.in/manual

Know Gate
Find various Koha tutorials and technical documents developed by NISCAIR.
URL: http://knowgate.niscair.res.in/blogs

Koha paid support
Libraries that need paid support can use the listing available at Koha official website. Users can
find commercial vendors in their country.
URL: https://koha-community.org/support/paid-support

Conclusion
The resources mentioned in this unit are helpful to keep in touch with the developments in the
Koha ILS project. Latest updates are essential to maintain Koha well in the workplace. Participating
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in the community discussions and involving in Koha social media groups are useful to update the
knowledge level.

